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DISK SPACE MANAGEMENT 

Over time, Clients using Window Book’s software may notice an increase in used disk space on the 
computer or server where the software is installed that may be impacting machine performance.  To 
manage and free up disk space, Window Book recommends the periodic archiving of data; as well as 
purging any unnecessary files.   
 

 The amount of data that is being saved to or archived on the computer/server varies by Client.  Client’s may 
have policies and/or procedures in place that require data be kept or archived in a certain way and/or for a 
specific amount of time; therefore, the guidelines presented in this document are to be superseded by a 
Client’s corporate policies and/or procedures.  If none exist, the guidelines should be based on a Client’s 
needs and not necessarily what is depicted in this document. 

This document identifies and provides instructions for the following: 

• Archiving Data:  Includes instructions for archiving both Mail.dat files and PPP data; and 

• Purging Data:  Includes instructions for purging DAT-MAIL backups; IMBM records; IM 
Scanning/Whittier Tagger files; Statements; Mail.dat files manually uploaded to PostalOne!®; PPP 
data; the MDSM plug-in’s logs archives; Files related to the MDR Client batch upload process; 
Software downloads; and the Pervasive SQL download folder. 

Both the Archiving and Purging Data sections also include the various methods that can be used to 
accomplish the archive or purge process for each (where applicable). 
 

 Only remove or delete those file specifically identified in this document!  Removing files other than those 
specified here may result in unwanted software behavior, loss of data, and/or downtime in production.  
Window Book’s Professional Services Team can assist with functions such as disk space clean-up and 
management; as well as, any additional computer-related challenges.  Go to 
http://www.windowbook.com/Services/Consulting to learn more. 

 
 
 

http://www.windowbook.com/Services/Consulting
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ARCHIVING DATA 

This section provides archiving instructions for data or files generated by Window Book’s software 
(including data backups), and the various tools or utilities that can be used for each.  Archiving can be 
performed manually, semi-automatically, or automatically depending on the tool or utility being used.  
 
The data or file types documented in this sections are: Mail.dat files; and PPP SQL data. 

ARCHIVING MAIL.DAT FILES 

Archiving job files (Mail.dat files) not only reduces disk space usage on the computer/server where the 
job files are being saved (archived files are automatically saved in a zipped format), it also makes DAT-
MAIL easier to use since it keeps the job list from being over-populated with mailings that are already 
completed.  This is essential if a Client is mailing under an Optional Procedure agreement which requires 
them to retain their job information for a period of at least one year.   
 
Mail.dat files can be archived using DAT-MAIL (manual), the DAT-MAIL Archiver utility or executable 
(semi-automated), and the Automation Scheduler’s Process Manager plug-in (fully automated).  
Instructions for using all four archiving methods are provided below. 

From Within DAT-MAIL 

There are two manual processes for archiving files from within DAT-MAIL.  They are:  

• Single or file-specific archiving from DAT-MAIL’s Select Mail.dat file to open window; and 

• Multiple file archiving that uses a cut-off number of days or a tagged list. 

 

SETTING THE DEFAULT ARCHIVING PARAMETERS 

Before proceeding with any of the archiving options for DAT-MAIL, set up the default archiving 
parameters that each of the archiving options will use.    
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Within DAT-MAIL, select ‘File’ > ‘Program Settings’ > ‘Program Setup’; 
 

 
 

 
 

The Setup screen will display.  Select the ‘Archive’ tab, and lick the Default Archive Directory button  

to create and/or select the folder  where the archived files will be saved to:  
 

 Depending on the system setup mapped drives may not always be available; therefore, using the UNC path 
name for the Default Archive Directory is preferred to avoid any possible connection issues (see image 
above). 

Specify the number of days the files need to be older than in order to be archived ; 
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If the Client wishes to only archive those files of a specific age that they have USPS approval on, select 

(check) the option to do so ;   
 
If the Client wishes to only archive those files of a specific age that have been released by P1, select 

(check) the option to do so ; 
 
If the Client has ‘Security’ enabled in their DAT-MAIL software, any automated archiving process will 

require a secure login ID and password to be able to run.  Enter the ‘Archiver Auto-Start ‘ Login ID  

and Password  (for more information about DAT-MAIL’s ‘Security’ feature, refer to the DAT-MAIL 
Secure User Guide available on the Window Book web site at:  
https://www.windowbook.com/Support/UserGuides).   
 
Click the OK button when finished.   The default archiving parameters have been set. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.windowbook.com/Support/UserGuides
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SINGLE MAIL.DAT FILES 

 These instructions assume that the default archiving parameters have already been set (refer to SETTING 
THE DEFAULT ARCHIVING PARAMETERS above). 

To select a specific file for archiving, open the Select Mail.dat file to open screen in DAT-MAIL. Click on 
the file to be archived, and click the Archive button. 
 

 
 
 
 
An Archive selected file… dialog will display.  Click the Cancel button 
to cancel the archive function, or click the Archive button to 
complete the archiving process.   
 
 
 
 
If the option ‘USPS Approval Required to Archive’ or ‘P1 Released Files 
only’ was selected and the file to be archived does not meet the 
corresponding criteria, the following Warning dialog will display: 
 
Click the OK button and resolve the issue. 
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MULTIPLE MAIL.DAT FILES 

 These instructions assume that the default archiving parameters have already been set (refer to SETTING 
THE DEFAULT ARCHIVING PARAMETERS above). 

Multiple Mail.dat files can be archived from DAT-MAIL on an as-needed basis.  To do this, click the 
‘Utilities’ menu item and then select the ‘Archive Old Mail.Dat Files’ menu option. 
 

 
 
 
 
The Archive Old Mail.dat files… dialog will display.   
 
The file path for the default archive directory will be 
displayed, along with the number of days in the 
‘Archive files older than’ field.  In addition, the status 
of both options (i.e. ‘USPS Approval Required to 
Archive’ and ‘P1 Release Files Only’) is also shown (if 
an options box is checked, the option is enabled).   
 
These defaults were previously set in DAT-MAIL (refer to SETTING THE DEFAULT ARCHIVING 
PARAMETERS above).  Only the number of days can be changed here if needed.  To change any of the 
remaining options previously set, the Client would have to cancel out of this screen and access the Setup 
screen, specifically the ‘Archive’ tab (refer to SETTING THE DEFAULT ARCHIVING PARAMETERS above). 
 
To archive the Mail.dat files, click the Process button;  
 
Or, to select specific files to archive from a list, click the Process Using Pick List button.   
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A Select Mail.dat Files to Archive screen will display that allows the Client to select (check) which files 
they want to archive.  Once the appropriate files are selected, click the Archive Selected Files button to 
complete the process. 
 

 
 

DAT-MAIL Archiver Utility 

In addition to the manual processes described above, files can be archived using the DAT-MAIL Archiver, 
which is a separate executable that is installed with DAT-MAIL, and resides on the server.  This is 
considered a semi-automated process and operates in the same manner as mentioned above for 
archiving multiple files based on a cut-off date, with the exception that the Client can set the DAT-MAIL 
Archiver to run automatically, at a specific time. 
 
This utility will need to be kept open (minimized) on the computer/server in order for it to run as 
scheduled.  Only the time the utility runs can be scheduled, so as long as the utility is open, it will run at 
the same time every day.  This function works well if the Client wants to run the utility on an ad-hoc 
basis, but wants to be able to schedule it to run automatically at a specific time during off-hours. 
 

 The same set up process for archiving Mail.dat files using DAT-MAIL is required for using the DAT-MAIL 
Archiver Utility (refer to SETTING THE DEFAULT ARCHIVING PARAMETERS in this Guide for more 
information). 

Open a command prompt and enter ‘MDARC707.EXE‘ to find the executable file or, using Windows 
Explorer, go to ‘WB\MDV\’ and locate it there.  Select the file and press the Enter key on the computer’s 
keyboard or double click on the file to launch it. 
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From the Utility’s main screen, click the Archive Old Files button.     
 

 
 
The Archive Old Mail.dat files… screen will display.  The file path for the default archive directory will be 
displayed, along with the number of days in the ‘Archive files older than’ field.  In addition, the status of 
both options (i.e. ‘USPS Approval Required to Archive’ and ‘P1 Release Files Only’) is also shown (if an 
options box is checked, the option is enabled).   
 
These defaults were previously set in DAT-MAIL (refer to SETTING THE DEFAULT ARCHIVING 
PARAMETERS above).  Only the number of days can be changed here if needed.  To change any of the 
remaining options previously set, the Client would have to cancel out of this screen (close the Utility) 
and access the Setup screen in DAT-MAIL, specifically the ‘Archive’ tab (refer to SETTING THE DEFAULT 
ARCHIVING PARAMETERS above). 
 
Set the ‘Start Time’ for when the Utility should run each day (or whenever the Utility is open on the 
computer or server).  In the example here, the Start Time is set to 5:00 p.m.; 
 

 
 
Click the Cancel key to cancel the archiving process and close the Utility or click the Start Timer button 
to start it.  Do not close the utility or the archiving process will not run!  The Utility is closed by either 
clicking the Cancel button or clicking the ‘X’ in the top right corner of the screen. 

Using the Automation Scheduler 

Using the Window Book Automation Scheduler’s Process Manager plug-in, the Client can configure the 
archival of Mail.dat files to happen automatically at specified intervals (the frequency with which it runs 
is defined in the plug-in’s configuration).  It runs an executable file that is automatically installed along 
with the DAT-MAIL software, and incorporates command-line arguments to further define exactly which 
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files should be archived, where they should be archived to, and to control how the system functions 
during the archiving process.   
Instructions for configuring the Process Manager plug-in are below: 
 

 These instructions assume the Window Book Automation Scheduler with Process Manager plug-in is 
already installed on the same computer/server that DAT-MAIL resides.  For information on how to obtain 
the Process Manger plug-in, contact your local Window Book Sales Representative.  Contact information 
can be found on Window Book’s web site at:  http://www.windowbook.com/Contact. 

 These instructions assume that the default archiving directory has  already been set.  If a Client has DAT-
MAIL’s ‘Security’ feature enabled the Auto-Start Login ID and Password must also be entered (refer to 
SETTING THE DEFAULT ARCHIVING PARAMETERS for instructions). 

Once all the archiving parameters have been set in DAT-MAIL, launch the Automation Scheduler on the 
computer/server where DAT-MAIL is installed. 
 
 
 
If the service is running, stop the service. 
 
 
 
Select (click) the Process Manager button.  
 
 
 
The Select Configuration screen will display.   
 
Click the drop down arrow and select “Add New Configuration” from the list provided.  Select (check) 
the ‘Expert View’ option, and click the Next button to continue.   
 

 

http://www.windowbook.com/Contact
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The Expert View screen will display.  Enter a name for the configuration making it easily identifiable (e.g. 
“Mail.dat File Archive”). 
 

 
 

 How often the archiving utility should run is dependent upon the Client’s volume, i.e. the volume of 
Mail.dat files being processed.  Set an appropriate time and duration for the archiving utility to run (it 
should generally be a time when the program is not being used, during off hours, or it could be a time 
during work hours that is set aside for this purpose, when Mail.dat processing is not taking place).   

 
Click the Next button to continue. 
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The General screen will display.  Select the ‘Custom Process’ option and browse for the archiving utility 
(executable file) which can be found in the DAT-MAIL program directory (i.e. ‘WB\MDV’).  The 
executable name is ‘MDARC707.exe’). 
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 The DAT-MAIL program directory is most often’ C:\WB\MDV’, but a Client’s set-up may be different.  The 
DAT-MAIL program directory can be confirmed within DAT-MAIL by selecting the Help menu item, then 
‘About DAT-MAIL’ menu option.  The ‘About DAT-MAIL’ dialog will display.  Click the ‘More About…’ button 
and then select the ‘Environment’ tab.  The DAT-MAIL Program Path will be listed under PATH NAMES. 

 
 
 
Click the Next button to continue. 
 
The Process Start Options screen will display.  Leave the ‘Exit without starting a new process’ option 
selected.  
 
Enter the appropriate command-line arguments.  Command-line arguments are as follows: 

• A=x - specifies the cut-off number of days the files to be archived have to be older than; 

• D=pathname – specifies the archive folder where the archived files should be saved to.  If this 
argument is not entered, the archive process will default to the directory set up in DAT-MAIL’s 
Export/Archive tab (refer to the SETTING THE DEFAULT ARCHIVING PARAMETERS section in this 
Guide); and 

• /SVC – tells the system that the Utility is being run from a service and to not pop-up any UI 
messages.  The MDARC707.exe or archive utility can be run manually, in which case the UI message 
will appear for the Client to see/use.   This is not wanted behavior when running it using the Process 
Manager plug-in. 
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Multiple command-line arguments should be entered leaving a single space between arguments (in the 
image below, the ‘D=pathname’ argument was not entered so the files will be automatically archived to 
the default archive directory set within DM – refer to the SETTING THE DEFAULT ARCHIVING 
PARAMETERS section in this Guide). 
 

 
 

Click the Next button to continue.  Click the Finish button.  Start  the service. 

ARCHIVING PPP DATA 

Clients can create their own MS SQL data backups at will using the PPP SQL Data Backup utility; either by 
using the utility itself, or through the Automation Scheduler’s Process Manager plug-in.  The Process 
Manager plug-in is configured by the Client and uses this same utility in an automated manner. 
 
 
 

PPP SQL Data Backup Utility 

With the installation of Window Book’s Postal Package Partner™ (PPP) software on the 
Client’s server, a data backup utility is also installed called PPP SQL Data Backup.  A shortcut 
for the utility is automatically created on the computer/server’s Desktop.   
 

 A shortcut for the Backup Data utility is only installed on the server where PPP is installed (or 
the computer in a stand-alone environment).  A short-cut to the utility is NOT found on any 
workstations in a server with workstation(s) environment.  Do not attempt to run the utility 
from a workstation in a server with workstation(s) environment. 
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 Before beginning the backup process, make sure to disconnect all users from the database and any 
application(s) using the PPP database until the backup has completed.  To insure that the backup is of the 
highest quality, the backup utility sets the database to SINGLE USER mode.  Once the backup is complete, 
the database is automatically set back to MULTIUSER mode. 

To perform an MS SQL data backup, launch the PPP SQL Data Backup utility.   
 
 
 
The Backup and Restore Center screen will display.  To determine 
where the backup of data is being filed to, click the ‘Setup’ menu 
option, and then the ‘Backup Location’ menu option. 
 
 
 
 
The Select Backup location… screen will display.     
 

 The Backup Folder location MUST be accessible by the login used to run the SQL Server service, as it 
performs the backups.  Folders that depend on remote, mapped drive letters CANNOT be used.  The use of 
UNC path names or folder locations is required. 

 
 
Click the OK button to return to the Backup and Restore 
Center screen. 
 
 
 
 
 

Click the Backup SQL Database button.  The Backup SQL 
Database screen will display.   
 
Click the Backup button to begin the backup process. 
 
 

 
When the backup is complete, a Backup completed confirmation dialog will 
display.  Click the OK button to end the process, and close the Backup and 
Restore Center screen. 
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Using the Automation Scheduler 

Using the Window Book Automation Scheduler’s Process Manager plug-in, the Client can configure the 
backup of PPP SQL data to happen automatically at specified intervals (the frequency with which it runs 
is defined in the plug-in’s configuration).  It runs a Data Backup utility that is automatically installed 
along with the PPP software, and incorporates command-line arguments to further define the archiving 
action.   
 
Instructions for creating a PPP backup configuring in the Process Manager plug-in are below: 
 

 These instructions assume the Window Book Automation Scheduler with Process Manager plug-in is 
already installed on the same computer PPP resides in a single workstation environment, or on the server in 
a server with workstation(s) environments  For information on how to obtain the Process Manger plug-in, 
contact your local Window Book Sales Representative.  Contact information can be found on Window 
Book’s web site at:  http://www.windowbook.com/Contact. 

Launch the Automation Scheduler on the computer/server where PPP is installed. 
 
 
If the service is running, stop the service. 
 
 
Select (click) the Process Manager button.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.windowbook.com/Contact
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The Select Configuration screen will display.   
 
Click the drop down arrow and select “Add New Configuration” from the list provided.  Select (check) 
the ‘Expert View’ option.   
 

 
 
Click the Next button to continue. 
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The Expert View screen will display.  Enter a name for the configuration making it easily identifiable (e.g. 
“PPP ‘wbdb’ Backup”). 
 

 There are two databases that should be backed up.  They are:  ‘wbdb’ and ‘wbdbcla’.  Only one database 
can be specified in a configuration; therefore, two separate configurations are required to backup each 
database.  In the example here, a configuration for automating the backup process for the ‘wbdb’ database 
is being created. 

 
 

 How often the utility should run is dependent upon the Client’s volume.  Set an appropriate time and 
duration for the utility to run (it should generally be a time when the program is not being used, during off 
hours, or it could be a time during work hours that is set aside for this purpose).   

 
Click the Next button to continue. 
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The General screen will display.  Select the ‘Custom Process’ option and browse for the Backup Data 
utility (‘wbBackup.exe’) which can be found in the ‘P3’ program directory (i.e. ‘WB\P3’). 
 

 
 

 
 
Click the Next button to continue. 
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The Process Start Options screen will display.  Leave the ‘Exit without starting a new process’ option 
selected.  
 
Enter the following command-line arguments, leaving a single space between arguments: 

• Action=backup – directs the utility to create a backup of a database; 

• CS=instancename – used to specify the name of the computer or server where the database is 
located, as well as the type of database.  The ‘instance name’ can be determined by opening 
Windows Explorer and going to the following location: ‘c:\Users\Public\Public Documents\Window 
Book’.   

Locate the file ‘wbDB.xml’.  Right click on the file and select the ‘Open’ menu option.   
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The ‘instance name’ will be located next to the ‘<ServerInstance> label (e.g. 
REMLBURISHW764\SQLEXPRESS’), the argument to enter would be:  
‘CS=REMLBURISHW764\SQLEXPRESS’ 
 

 

• DB=database to be backed up – the name of the database to be backed up is entered here.  The 
names of the two databases that should be backed up are:  ‘wbdb’ and ‘wbdbcla’. 

 Only one database can be specified in a configuration; therefore, two separate configurations are required 
to backup each database. 

 
 
Click the Next button to continue.  Click the Finish button.   
 
Repeat the above instructions to create an automated backup process for the ‘wbdbcla’ database. 
 

Start  the service. 
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PURGING DATA 

This section provides purging instructions for data or files generated by Window Book’s software 
(including data backups), and the various tools or utilities that can be used for each (where applicable).   
 

 Only remove or delete those file specifically identified in this document!  Removing files other than those 
specified here may result in unwanted software behavior, loss of data, and/or downtime in production.  
Window Book’s Professional Services Team can assist with functions such as disk space clean-up and 
management; as well as, any additional computer-related challenges.  Go to 
http://www.windowbook.com/Services/Consulting to learn more. 

 A Client’s corporate policy regarding data archiving and/or purging should be adhered to at all times.  If 
one does not exist, the guidelines followed should be based on a Client’s needs and not necessarily what is 
depicted in this document; however, Window Book strongly recommends that at a minimum, two backups 
be kept at all times. 

DAT-MAIL BACKUPS 

Data backups for DAT-MAIL can be found in the ‘WB\MDV\Backup500’ and 
‘WB\PMW\Data\Backup_SQL’ directories on the computer/server where DAT-MAIL is installed. 
 
To identify and purge any unnecessary DAT-MAIL data backups, use Windows® Explorer to first locate 
the ‘WB\MDV\Backup500’ directory. 
 
Backups can be saved as copies of files within folders or files compressed into one .zip file (backup type 
used is specified when the software is installed).  Both file types are named using the date the backup 
occurred, in the following format:  YYYYMMDD or 20140610 (i.e. June 10, 2014).  Identify the backup 
files that can be purged.   
 
 

 Window Book recommends retaining a minimum of two backup files at all times; however, always defer to 
a Client’s corporate policy in regards to data retention. 

 
 

http://www.windowbook.com/Services/Consulting
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Example of backup files 
saved in date-stamped 
folders… 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Example of backup files 
compressed into a .zip format… 
 
 
 
 
 
 
 
 
 
 
 
 

Remove them from the computer/server by deleting them and/or moving them to an independent 
storage device. 
 
Next, locate the ‘WB\PMW\Data\Backup_SQL’ directory.   
 
Backups can be saved as copies of files within folders or files compressed into one .zip file (backup type 
used is specified when the software is installed).  Both file types are named using the date the backup 
occurred, in the following format:  YYYYMMDD or 20140610 (i.e. June 10, 2014).  Identify the backup 
files that can be purged. 
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 Window Book recommends retaining a minimum of two backup files at all times; however, always defer to 
a Client’s corporate policy in regards to data retention. 

 
 
 
 
 
Example of backup files 
saved in date-stamped 
folders… 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Example of backup files 
compressed into a .zip format… 
 
 
 
 
 
 
 
 
 

 
Remove them from the computer/server by deleting them and/or moving them to an independent 
storage device. 
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MAIL.DAT FILES MANUALLY UPLOADED TO P1 

A copy of the MAIL.dat files that are manually uploaded to PostalOne! (P1) using the MDR Client 
software are kept in the designated export folder that is specified in the ‘PostalOne’ tab of DAT-MAIL’s 
Setup screen.   
 

 
To display the Setup screen: From DAT-MAIL’s main or home screen,  
select ‘File’ > ‘Program Settings’ > ‘Program Setup’. 

 
 
Over time, these files can become large in number and should be deleted to manage disk space on the 
computer or server.  Window Book recommends keeping two months’ worth of these files.  Anything 
beyond two months can be deleted using Windows Explorer. 
 

 A Client’s corporate policy regarding data archiving and/or purging should be adhered to at all times.  If 
one does not exist, the guidelines followed should be based on a Client’s needs and not necessarily what is 
depicted in this document. 
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On the computer or server, open Windows Explorer.  Navigate to the MDR Client folder designated for 
Mail.dat files to be exported (refer to image above).   
 

 
 
Identify, select, and delete any Mail.dat files that are beyond two months old. 
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IMBM RECORDS 

There are three options for purging IMBM records:  within DAT-MAIL; using the Automated Scheduler; 
and using the SQL Server Management Studio. 

Within DAT-MAIL 

The DAT-MAIL ‘File Utilities’ menu contains purging functions for the MS SQL database (‘wbdb’) for the 
following items: 

• Old Pallet Tracking Records; 

• Old IMTL/IMCL Barcodes from IMBM; 

• Old IM Piece Barcodes from IMBM; and 

• Old Log Records from the Central Logging.  Central Logging logs major transactions in the ‘wbdb’ SQL 
database, such as importing, generating statements, and Postal One! submissions.  It is a good idea 
to purge these records from time to time, although they do not take up as much as space as some 
other files.   

 
 
With the exception of Old Pallet Tracking Records which allows the Client to select and purge individual 
records, all other items are selected and purged using a date range. 
 

 Be aware that once records or items are purged, they cannot be restored. 
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Once the purging process is complete, a confirmation dialog will 
display confirming the number of records that were purged.  A 
progress bar does not display during the purging process, but 
depending on the number of records that are being purged, it may 
take some time for the purging process to complete and the 
confirmation dialog to display.   
 
 
 
 
If no records are purged, a similar confirmation dialog 
will display. 
 
 
 
 
 
 
 
If there is a problem with the connection to the MS SQL database that contains the records (‘wbdb’), 
resulting in no records being purged, an exception dialog will display stating that a connection to the 
database could not be established.  If this occurs, the Client should contact their IT/System 
Administrator to confirm that the user attempting the purge has the proper rights and connections 
needed for access to the SQL database (‘wbdb’). 
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Using the Automation Scheduler 

 These instructions assume that the default archiving directory has  already been set (refer to the SETTING 
THE DEFAULT ARCHIVING PARAMETERS section above). 

Using the Window Book Automation Scheduler’s Process Manager plug-in, the Client can configure the 
purge of IMBM records to happen automatically at specified intervals (the frequency with which it runs 
is defined in the plug-in’s configuration).   
 
The Process Manager plug-in uses an IMBC purge executable file that automatically gets installed with 
DAT-MAIL.  Using a command-line argument that is entered into the configuration, the Client can tell the 
Process Manager plug-in the range and type of records to purge.   
 
Instructions for configuring the Process Manager plug-in are below: 
 

 These instructions assume the Window Book Automation Scheduler with Process Manager plug-in is 
already installed on the same computer/server that DAT-MAIL resides.  For information on how to obtain 
the Process Manger plug-in, contact your local Window Book Sales Representative.  Contact information 
can be found on Window Book’s web site at:  http://www.windowbook.com/Contact. 

Launch the Automation Scheduler on the computer/server where DAT-MAIL is installed. 
 
 
If the service is running, stop the service.    
 
 

 
 
 
Select (click) the Process Manager button.  
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

http://www.windowbook.com/Contact
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The Select Configuration screen will display.  Select (check) the ‘Expert View’ option and click the Next 
button to continue.   
 

 
 
The Expert View screen will display.  Name the plug-in configuration to identify what its purpose is (e.g. 
“IMBM IMTCL Purge”), and provide a description for it.  Then click the Next button to continue. 
 

 
 

 How often the utility is run is dependent upon the volume of Mail.dat files being processed and the length 
of time the Client wants/is required to keep the data.  Set an appropriate time for the purge utility to run (it 
should generally be a time when the program is not being used, during off hours, or it could be a time 
during work hours that is set aside for this purpose, when Mail.dat processing is not taking place).   
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The General screen will display.  Select the ‘Custom Process’ option and click the Browse… button to 
locate and select the purge utility (executable file) which can be found in the DAT-MAIL program 
directory (i.e. ‘WB\MDV’).  The executable name is ‘MDPurgeIMBC.exe).  
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 The DAT-MAIL program directory is most often’ C:\WB\MDV’, but a Client’s set-up may be different.  The 
DAT-MAIL program directory can be confirmed within DAT-MAIL by selecting the Help menu item, then 
‘About DAT-MAIL’ menu option.  The ‘About DAT-MAIL’ dialog will display.  Click the ‘More About…’ button 
and then select the ‘Environment’ tab.  The DAT-MAIL Program Path will be listed under PATH NAMES. 

 
 
Click the Next button to continue.   
 
The Process Start Options screen will display.  Leave the default option of ‘Exit without starting a new 
process’ selected and enter the one or more of the available command-line arguments for specifying 
which records are to be purged by the MDPurgeIMBC.exe file (if more than one argument is entered, 
separate the arguments with a single space, e.g. /PURGIMTCL /PURGIMPCB): 

• /PURGIMTCL – This flag will purge IMTL and IMCL data (tray and container barcodes); 

• /PURGIMPCB – This flag will purge IM Piece barcodes; and 

• /PURGCENTRALLOG – This flag will purge Central Logging data. 
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A second command-line argument is required to control the date range of the records to be purged.  
The available command-line arguments for date ranges are (these arguments cannot be modified): 

• /DR4560 – purges records 45 to 60 days old; 

• /DR6090 – purges records 60 to 90 days old; 

• /DR90120 – purges records 90 to 120 days old; 

• /DROVR120 – purges records older than 120 days; and 

• /DR0VR365 – purges records older than 365 days (1 year). 

 
The above command-line arguments cannot be modified; however, there is one argument that allows 
the Client to specify their own cut-off date for purging records:  DROVRman=xxx.  This argument should 
not be preceded by a forward slash (i.e. ‘/’) like the other arguments (command parameters with an “=” 
do not use a forward slash).  For example, if entered, the command-line argument ‘DROVRman=75’ 
would purge records older than 75 days. 
 
Only one of the above date range arguments can be specified for each data purge.  If more than one 
type of data is being purged with this configuration (two or more command-line arguments are 
entered), the date argument will control the date range for all the data being purged with this 
configuration.  If the Client wants to specify different date parameters for each type of data being 
purged, then multiple or separate configurations will need to be created. 
 
Enter the date command-line argument after the data-type argument – leaving a single space in 
between them (this example uses ‘/DR4560’, i.e. records between 45 and 60 days old will be purged). 
 

 
 
Click the Next button, and then click the Finish button.  The configuration is complete!   
 

Start the service . 
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 Clients with very large Mail.dat files that need to purge IM Piece barcodes more frequently than Tray and 
Container barcodes can set up two separate configurations using a different name for each.  Separate 
configurations should not be set to run at the same time (they could be, for instance, scheduled to run on 
different days). 

Using SQL Server Management Studio 

IMBM container barcode SQL records can be purged by running a query within the MS SQL Management 
Studio.  The following is an example of how to do this for records that are more than 90 days old. 
 

 The query can use any number of days as the cut-off number (e.g. 60 days, 120 days, etc.).  It is wholly 
dependent on the Client’s needs. 

 A Client’s corporate policy regarding data archiving and/or purging should be adhered to at all times.  If 
one does not exist, the guidelines followed should be based on a Client’s needs and not necessarily what is 
depicted in this document. 

 

STEP 1 – DETERMINING THE NUMBER OF RECORDS THAT WILL BE PURGED 

The first step is to determine how many records meet the criteria for purging – in this case, the number 
of records that are more than 90 days old.   

 
 
 
 
 
From the server’s desktop, click the Start button and 
launch the ‘SQL Server Management Studio’. 
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Connect to the appropriate server.   
 
 
 
 
 
 
 
Within the Microsoft SQL Server Management Studio, click the New Query icon. 
 

 
 
There are two query options for obtaining the number of records that meet the purge criteria – in this 
case, records that are more than 90 days old:  Display Total Number; or Display Actual Records.  

QUERY OPTION 1:  DISPLAY TOTAL NUMBER 
Query option 1 will result in providing a single total record count, but will not display the records that 
make up that count. 
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Cut and paste the following two-line script into the SQLQuery1 window and click the Execute button: 
 
Use WBDB 
Select count (*) from dbo.IMBM where DateDiff(day,DateOfMailing,GetDate()) > 90 
 

 
 
A Results window will display below the SQLQuery1 window, and will list the number of records found 
once the execution of the query is complete – in this case:  111,178. 
 

 
 

QUERY OPTION 2:  DISPLAY ACTUAL RECORDS 
Query option 2 will result in providing a total record count along with displaying all of the records that 
make up that count. 
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Cut and paste the following five-line script into the SQLQuery1 window and click the Execute button: 
 
Use WBDB 
Select *, DateDiff(day,DateOfMailing,GetDate()) as Age 
From 
dbo.IMBM 
order by age 
 

 
 
In this case, the actual records that meet the query’s criteria display in the Results window.  These are 
the records that will be purged using the delete function.  If there is a large number of records, this 
query can take some time to complete. 
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STEP 2 – DELETING (PURGING) IMBM RECORDS 

 Depending on the number of records there are to be purged or deleted, the delete process can take some 
time.  If the number of records to be deleted is large (e.g. 111,178), Window Book recommends performing 
one deletion using a block of 10,000 records to determine the actual time will take to delete the entire set. 
More information is provided further along in this section. 

 
 
 
 
From the server’s desktop, click the Start button and 
launch the ‘SQL Server Management Studio’. 
 
 
 
 
 
 
 
 
 

 
 
 
Connect to the appropriate server.   
 
 
 
 
 
 
Within the Microsoft SQL Server Management Studio, click the New Query icon. 
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Type or cut/paste the following two-line script into the SQLQuery1 window and click the Execute button: 
 
Use WBDB 
Delete top(10000) from dbo.IMBM where DateDiff(day,DateOfMailing,GetDate()) > 90 
 

 
 
The top 10000 rows or records that are more than 90 days old will be deleted.  This will be confirmed in 
the Message window that displays below the query window.   
 

 
 
How long the query/deletion takes is displayed in the bottom right of the screen (see image above).  The 
total amount of time the query took, multiplied by how many times 10,000 divides into the total 
number of records to be purged or deleted (e.g. 111,178), will provide an idea of how long the deletion 
of the entire number of records will take. 
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One strategy for deleting efficiently is to start by deleting smaller numbers, and depending on how long 
it takes for the query to complete, increasing the number.  How long it takes will be a good determiner 
of what the impact would be of upping the “10000” number used in the “Top(10000)” command. 
 

 If the number chosen is too large, a message may display on the server/computer that the “server has 
insufficient RAM” (or similar).  If this occurs, lower the number until the message no longer displays. 

Once the optimal number is determined, queries can be pasted consecutively so as to avoid having to 
wait for each query to finish.  In the example being used here, the optimal number of records is 35,000 
(it is possible for the number to be even higher). 
 

 
 
When this query is executed, the results will display in the Messages window below the query window: 
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In the example being used here, 105,000 IMBM records that were more than 90 days old were deleted, 
and the query took 1 minute 36 seconds to complete (again, the number of deletions can be much 
higher for high-volume, high-performance systems). 

IM SCANNING / WHITTIER TAGGER FILES 

If a Client is using IM Scanning or a Whittier Tagger, the amount of the log files and/or Tagger files 
created can grow quite large over time.  There are two options within DAT-MAIL that allow the Client to 
remove or purge the both the log files and the Tagger files that the Client no longer needs. 
 

 The information provided here pertains to the use of DAT-MAIL version 11.15.17.05 or newer. 

Log Files 

To remove or purge the log files, from DAT-MAIL’S main screen, select ‘Other Programs’ > ‘IM Scanning’ 
> ‘View Scan Manager Requests Log’.   
 

 
 
The View Import Siblings Logs screen will display.   Click the Remove Old Log Records button. 
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A Remove old log records screen will display.  Enter the cut-off date in the field provided, or select it by 
clicking the calendar icon that is adjacent to the date field.   
 
Log records older than the date entered/selected 
will be deleted or purged when the OK button is 
clicked (clicking the Cancel button will abort the 
delete or purge process). 
 

 Be aware that once records or items are purged, they cannot be restored. 

Whittier Tagger Files 

To remove or purge the exported Tagger files, from DAT-MAIL’s main screen, select ‘Other Programs’ > 
‘IM Scanning’ > ‘Setup’. 
 

 
 
The Tagger Settings screen will display.  Click the Purge Old Exports button. 
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The Remove Old Tagger Files screen will display, 
prompting the Client to enter the number of 
days the files to be purged or deleted must be 
older than. 
 
Click the Cancel button to cancel the purging 
process or click the Purge Old Files button to 
complete the purging process. 
 

 Be aware that once records or items are purged, they cannot be restored. 

STATEMENTS 

The Statements module in DAT-MAIL contains purging functions accessed from the Utilities menu for 
the following: 

• Statements (can also be archived before being purged); 

• Orphaned Statement Detail; 

• Drop Ship Certifications (can also be archived before being purged); and 

• Orphaned Drop Ship Certifications.  

 
 

 It is important to note that if the ‘Purge Orphaned Statement Detail’ and/or ‘Purge Orphaned Drop Ship 
Certifications’ is selected the purge is immediate and automatic for all the orphaned detail and/or 
certifications and cannot be undone. 

Included with both the Statements purge function and the Drop Ship Certifications function is also the 
option to archive the data being purged before the purge is completed (files will be archived to the 
default archive directory set within DAT-MAIL – refer to the SETTING THE DEFAULT ARCHIVING 
PARAMETERS section in this Guide).  After Statements and/or Drop Ship Certifications are archived and 
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purged, the archived files can be restored from the same Utilities menu (refer to the ‘Restore Archived 
Data’ menu option in the image above). 
 
 
 
 
Statements can be purged by Date, Job (the job itself or job 
by date), or Job and Lot.  The Client has the option to skip 
statements with no date and/or archive the records before 
deleting.  
 
 
 
 
 
 
 
 
Drop Ship Certifications are purged by date.  The Client can skip 
those statements or certifications that have no date and/or they 
can archive the records before purging them.   
 
 
 
 

PPP MS SQL AND PSQL DATA 

Clients can create their own MS SQL data backups at will using the PPP SQL Data Backup utility; either by 
using the utility itself, or through the Automation Scheduler’s Process Manager plug-in.  The Process 
Manager plug-in is configured by the Client and uses this same utility in an automated manner. 
 
In addition, PPP automatically generates data backups of both Pervasive SQL (PSQL) and MS SQL data 
and stores them in default SQL backup folders .  The PPP PSQL data backups can only be purged using 
Windows® Explorer; however, the MS SQL data backups can be purged using the same PPP SQL Data 
Backup Utility, the Automation Scheduler’s Process Manager plug-in, or Windows® Explorer. 

Purging PPP MS SQL Backups 

There are three methods for purging the PPP MS SQL backups:  using the PPP SQL Data Backup Utility; 
the Automation Scheduler with Process Manager plug-in; and Windows® Explorer. 
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PPP SQL DATA BACKUP UTILITY (PURGING) 

The PPP SQL Data Backup Utility is installed automatically with PPP on the Client’s server.  A 
shortcut for the utility is automatically created on the computer/server’s Desktop.  This 
same utility can also be used to purge PPP MS SQL data backups. 
 

 A shortcut for the Backup Data utility is only installed on the server where PPP is installed (or 
the computer in a stand-alone environment).  A short-cut to the utility is NOT found on any 
workstations in a server with workstation(s) environment.  Do not attempt to run the utility 
from a workstation in a server with workstation(s) environment. 

 Before performing any purging of old, archived PPP MS SQL data as part of a Client’s disk clean-up process, 
Window Book recommends performing a PPP data backup (where applicable) using this utility to ensure 
that a backup of the most current data is available.  Refer to the PPP SQL Data Backup Utility section in this 
Guide. 

 Before beginning the purge process, make sure to disconnect all users from the database and any 
application(s) using the PPP database until the purge is completed.  

From the Client’s server, launch the utility (refer to the PPP SQL Data Backup Utility section in this 
Guide).  The Backup and Restore Center screen will display. 
 
 
 
Select the ‘Action’ menu item. 
 
Select the ‘Purge Backups’ menu option. 
 
 
 
 
 
 
 
The Purge SQL Backup screen will display.  Within the screen all the pre-existing backups will be listed.   
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Enter the number of days the 
purge utility should use as a cut-
off for selecting which backups to 
delete or purge (in the screen 
shot left, 7 days have been 
entered). 
 
Click the Cancel button to cancel 
the purge process, or click the 
Purge button to complete the 
purge process. 
 

 

 The purge utility does not touch the PSQL and MS SQL data backups automatically generated by PPP and 
stored in the system’s default backup folders.  It purges the MS SQL backups that are stored in the folder 
specified during the utility’s backup process (refer to the PPP SQL Data Backup Utility section in this Guide).   

 
When purging, the utility will always leave at least three backups no 
matter what the parameters are that were specified before running 
it.  If the number of days specified does not allow for at least three 
backups to remain, a Purge Cancelled dialog will display. 
 
 

USING THE AUTOMATION SCHEDULER 

Using the Window Book Automation Scheduler’s Process Manager plug-in, the Client can configure the 
automated purge of PPP MS SQL backup files at specified intervals (the frequency with which it runs is 
defined in the plug-in’s configuration).  It runs the same PPP SQL Data Backup utility used to create PPP 
MS SQL data backups that is automatically installed along with the PPP software, and incorporates 
command-line arguments to further define the purging process.   
 

 The purge utility does not touch the PSQL and MS SQL backups automatically generated by PPP and stored 
in the system’s default backup folders.  It purges the MS SQL backups that are stored in the folder specified 
during the utility’s backup process (refer to the PPP SQL Data Backup Utility section in this Guide).   

Instructions for creating a PPP purge configuring in the Process Manager plug-in are below: 
 

 These instructions assume the Window Book Automation Scheduler with Process Manager plug-in is 
already installed on the same computer PPP resides in a single workstation environment, or on the server in 
a server with workstation(s) environments  For information on how to obtain the Process Manger plug-in, 
contact your local Window Book Sales Representative.  Contact information can be found on Window 
Book’s web site at:  http://www.windowbook.com/Contact. 

http://www.windowbook.com/Contact
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Launch the Automation Scheduler on the computer/server where PPP is installed. 
 
 
If the service is running, stop the service. 
 
Select (click) the Process Manager button.  
 

 
 
The Select Configuration screen will display.   
 
Click the drop down arrow and select “Add New Configuration” from the list provided.  Select (check) 
the ‘Expert View’ option.   
 

 
 
Click the Next button to continue. 
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The Expert View screen will display.  Enter a name for the configuration making it easily identifiable (e.g. 
“PPP Data Purge”). 
 

 
 

 How often the utility should run is dependent upon the Client’s volume.  Set an appropriate time and 
duration for the utility to run (it should generally be a time when the program is not being used, during off 
hours, or it could be a time during work hours that is set aside for this purpose).   

 
Click the Next button to continue. 
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The General screen will display.  Select the ‘Custom Process’ option and browse for the Backup Data 
utility (‘wbBackup.exe’) which can be found in the ‘P3’ program directory (i.e. ‘WB\P3’). 
 

 
 

 
 
Click the Next button to continue. 
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Enter the following command-line arguments, leaving a single space between arguments: 

• Action=purge – directs the utility to purge data backup files; 

• Purgedays=x – specifies the cut-off number of days the files to be archived have to be older than. 

 

 
 

Click the Next button to continue.  Click the Finish button.  Start  the service. 

USING WINDOWS® EXPLORER 

PPP automatically creates data backups for both Pervasive SQL (PSQL) and MS SQL data.  These two data 
backups – different than the backups created by the PPP SQL Data Backup Utility – are stored in 
separate locations. 
 
MS SQL data backups for PPP are saved in the ‘WB\SQLBackup’ directory on the computer/server where 
PPP is installed.   
 

 Before purging any existing backups, Window Book recommends performing an archive or backup of the 
most current PPP data (refer to PPP SQL Data Backup Utility above for instructions).  This same archiving 
method can be automated if preferred (refer to the Using the Automated Scheduler section located under 
“Archiving PPP Data” above). 

 The same utility used for archiving the PPP MS SQL files can also be used for purging the archived backup 
files.  The utility can be accessed directly for purging (refer to PPP SQL DATA BACKUP UTILITY (PURGING) 
above), or can be set up as an automated process (refer to USING THE AUTOMATION SCHEDULER found 
under “Purging PPP MS SQL Backups” above).  Either method can be used as an alternative to using 
Windows® Explorer for purging or deleting old, archived MS SQL data; however, it is necessary to stipulate 
the correct location when purging using the utility and/or Automation Scheduler. 
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 Window Book recommends retaining a minimum of two backup files at all times; however, always defer to 
a Client’s corporate policy in regards to data retention. 

To identify and purge any unnecessary PPP MS SQL data backups, use Window Explorer to locate the 
‘WB\SQLBackup’ directory.  Backups are named using the date the backup occurred, in the following 
format:  YYYYMMDD or 20140610 (i.e. June 10, 2014).   
 
 
 
 
Identify the backup 
files that can be 
purged.   
 
Remove them from 
the computer/server 
by deleting them 
and/or moving them 
to an independent 
storage device. 
 
 
 
 
 
 
 
 

Purging PPP PSQL Backups 

PPP automatically creates data backups for both Pervasive SQL (PSQL) and MS SQL data.  These two data 
backups – different than the backups created by the PPP SQL Data Backup Utility – are stored in 
separate locations.   
 
This section deals specifically with the PSQL backups.  For information about purging the MS SQL 
backups, refer to Purging PPP MS SQL Backups section in this Guide.  Only Windows Explorer can be 
used to purge any unnecessary PPP PSQL data backups. 

USING WINDOWS® EXPLORER 

PSQL data backups for PPP (where applicable) can be found in the ‘WB\P3\Data\BackupPSQL’ directory 
on the computer/server where PPP is installed.   
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 Window Book recommends retaining a minimum of two backup files at all times; however, always defer to 
a Client’s corporate policy in regards to data retention. 

 The PPP SQL Data Backup Utility used for archiving and/or purging PPP’s SQL backup files, cannot be used 
for purging the PSQL data backup files (refer to PPP MS SQL AND PSQL DATA above). 

To identify and purge any unnecessary PPP PSQL data backups, use Window Explorer to locate the 
‘WB\P3\Data\BackupPSQL’ directory.  Backups are named using the date the backup occurred, in the 
following format:  YYYYMMDD or 20140610 (i.e. June 10, 2014).   
 
 
 
Identify the backup 
files that can be 
purged.   
 
Remove them from 
the computer/server 
by deleting them 
and/or moving them 
to an independent 
storage device. 
 
 
 

MDSM PLUG-IN LOG ARCHIVES 

The Automation Scheduler’s MDSM plug-in automatically creates an archive of log files that can be 
purged to assist in managing a server’s disk space.  Purging these files is a manual process and done 
through Windows Explorer. 
 
On the server or computer where the Automation Scheduler with MDSM plug-in is installed, launch a 
Windows Explorer window. 
 
Navigate to:  c:\ProgramData\Window Book\Scheduler\MDSM\Logs\Archives. 
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 If the ‘ProgramData’ folder is not visible, click the ORGANIZE button and select the “Folder and search 
options” menu item.  In the ‘Folder Options’ screen, click the “View” tab and select or enable the ‘Show 
hidden files, folders, and drives’ option.  Click the APPLY button and then the OK button to close the screen.  
The ‘ProgramData’ folder will now be visible. 

 
 
With the ‘Archives’ folder displayed, delete all but two of the archived log files. 
 

 Window Book recommends retaining a minimum of two archive log files at all times; however, always 
defer to a Client’s corporate policy in regards to data retention.   

 
 

 Only remove or delete those file specifically identified in this document!  Removing files other than those 
specified here may result in unwanted software behavior, loss of data, and/or downtime in production.  
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PURGING FILES RELATED TO THE MDR CLIENT BATCH 
UPLOAD PROCESS 

If Clients are using the Automation Scheduler's MDSM plug-in, Windows Explorer is used to purge or 
delete files related to and/or generated by the MDR Client batch upload process (i.e. Status Receipts; 
Failed, Rejected, and Successful Files; PostalOne! Debug Log Files). 

 
If Clients are using MailDrop Engine, these same files can be purged from within MailDrop Engine; 
specifically, the 'Advanced Settings' tab.  For more information, refer to the MailDrop Engine 

Installation & User Guide available on Window Book's web site.  Registration and/or login is required. 
 
Instructions for purging these files using Windows Explorer (Automation Scheduler/MDSM plug-in users 
only) are provided below. 

Status Receipts 

If Mail.dat files are being uploaded to P1 using the automated MDR Client batch upload process in 
conjunction with the Automation Scheduler’s MDSM plug-in, P1 generates status receipt files for the 
various states that the Mail.dat file goes through during the upload process.  As the number of these 
files increase over time, the amount of disk spaced used to keep them can eventually cause computer or 
server performance issues. 
 
The status receipt files being addressed here are saved to a sub-folder located within the ‘Receipts’ 
folder on the computer or server.  The name of the sub-folder is “Processed” (i.e. 
‘…\Receipts\Processed’).  Both of these folders will be located in the MDR Client directory. 
 
The location of the ‘Receipts’ folder can be identified within the Automation Scheduler’s MDSM plug-in; 
specifically, the Configuration Data screen. 
 
 
 

https://www.windowbook.com/Support/UserGuides


 

 
Page 56 of 61  ©2017 Window Book, Inc.  All Rights Reserved. 

 Disk Space Management 

 
 
 
 
 
 
Click the Show Settings 
button. 
 
 
 
 
 
 
 

To display the Configuration Data screen: Launch the Automation Scheduler, select the  
‘MDSM - Mail.dat Service Manager’ plug-in, and click the Next button until the 
Configuration Data screen displays.  To close the MSDM plug-in, click the Finish button. 

 
 
The USPS MDR Client Settings screen will display.  Note the location of the ‘Status Receipts’ or ‘Receipts’ 
folder. 
 

 
 
Using Windows Explorer, navigate to that ‘Receipts’ folder and then the ‘Processed’ sub-folder; identify, 
select, and delete all receipt files that are beyond two months old. 
 

 Within the ‘Receipts’ folder, a second sub-folder called ‘Unidentified’ may be present.  Disregard this folder, 
i.e. do not delete files (if any) located in this folder! 
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Failed, Rejected and Successful Files 

If Mail.dat files are being uploaded to P1 using the automated MDR Client batch upload process in 
conjunction with the Automation Scheduler’s MDSM plug-in, the MDSM moves the Mail.dat files to one 
of three specific folders on the computer or server, depending on their job status, i.e. ‘Failed’; 
‘Rejected’; or ‘Successful’.  As the number of these files increase over time, the amount of disk spaced 
used to keep them can eventually cause computer or server performance issues. 
 
The locations of all three of these folders can be found in the Automation Scheduler’s MDSM plug-in; 
specifically, the Configuration screen. 

 
 
 
 
Click the Show Settings 
button. 
 
 
 
 
 
 
 
 
 

To display the Configuration Data screen: Launch the Automation Scheduler, select the 
‘MDSM - Mail.dat Service Manager’ plug-in, and click the Next button until the 
Configuration Data screen displays.  To close the MSDM plug-in, click the Finish button. 

 
 
The USPS MDR Client Settings screen will display.  Note the location of the ‘Failed’ or ‘Rejected’ and 
Successful’ folders. 
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Within both the ‘Failed’ and ‘Rejected folders, there will be a ‘History’ sub-folder.  Files in these folders 
are the original Mail.dat files that failed P1 validation or were rejected by P1.  Being that the files are 
located in the ‘History’ sub-folder means that whatever caused the failure or rejection was corrected 
and the files were, at some point, re-submitted to P1.  The ‘corrected’ or ‘fixed’ Mail.dat files that 
eventually passed P1 validation were then moved to the ‘Successful’ folder. 
 
Using Windows Explorer, navigate to each of these two ‘History’ sub-folders (i.e. ‘…\Failed\History’; 
‘…\Rejected\History’); identify, select, and delete all Mail.dat files that are beyond two months old. 
 
In addition, using Windows Explorer, navigate to the ‘Completed Files Folder’ or ‘Successful’ folder; 
identify, select, and delete all Mail.dat files that are beyond two months old. 
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PostalOne! Debug Log Files 

If Mail.dat files are being uploaded to P1 using the automated MDR Client batch upload process in 
conjunction with the Automation Scheduler’s MDSM plug-in, P1 generates log files during the upload 
and validation process.  Once a certain number of log files is reached, P1 generates a ‘DebugLog’ zipped 
file and saves them to the MDR Client folder on the computer or server.  Each DebugLog file name 
includes a date stamp.   
 
These DebugLog files build up quickly and over time can take enough disk space to warrant some 
attention.  Window Book recommends leaving or keeping the three most recent DebugLog files and 
deleting the rest.  Use Windows Explorer to navigate to the MDR Client folder to identify, select and 
delete any un-necessary DebugLog files. 
 

 Window Book recommends retaining a minimum of the three most recent DebugLog files at all times; 
however, always defer to a Client’s corporate policy in regards to data retention. 
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PURGING SOFTWARE DOWNLOADS 

Updates to Window Book software are downloaded from the Window Book web site and saved to the 
computer/server before being run.  After a time, if these downloads are not deleted, the number of 
downloaded files can build up, using unnecessary disk space.   
 
Locate the ‘Downloads’ folder on the computer/server and delete any Window Book downloaded files 
saved there. 
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PURGING THE PERVASIVE SQL DOWNLOAD FOLDER 

Depending on the age of the original DAT-MAIL installation, the installation of Pervasive SQL was first 
saved to its own download folder on the C: drive of the Client’s computer/server.   
 

 
 
Once the installation of DAT-MAIL is complete, this download folder and its contents are no longer 
necessary and can be deleted.  Confirm that the “PSQL Download” folder is no longer present on the 
computer/server.  This will assist with disk space management for the Client. 


